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Overview of CADTranslate

About Theorem

THeOREM

CAD PUBLISH

@ THEOREM

CAD TRANSLATE

Theorem Solutions is a world leader in the field of Engineering Data Services and Solutions. This leadership
position stems from the quality of our technology and the people in the company. Quality comes not only from
the skills and commitment of our staff, but also from the vigorous industrial use of our technology & services
by world leading customers.

We are proud that the vast majority of the world's leading Automotive, Aerospace, Defense, Power
Generation and Transportation companies and their Supply chains use our products and services daily.
Working closely with our customers, to both fully understand their requirements and feed their input into our
development processes has significantly contributed to our technology and industry knowledge.

Theorem Solutions is an independent UK headquartered company incorporated in 1990, with sales and
support offices in the UK and USA. Theorem has strong relationships with the major CAD and PLM vendors,
including; Autodesk, Dassault Systemes, ICEM Technologies (a Dassault company), PTC, SolidWorks, Spatial
Technology and Siemens PLM Software. These relationships enable us to deliver best in class services and
solutions to engineering companies worldwide.

© 2025 Theorem Solutions. All Rights Reserved




@ THeOREM User Guide CATIA V5 - JT

Theorem’s Product Suite

Theorem have 3 main Product brands. These are:

&)

CADTranslate

CAD Data Exchange: Seamless and robust data translation between CAD
and Visualization formats.

See our website for more details.

CADPublish

Interactive Documentation: 3D PDF Publisher and Composer. Making CAD
\ data accessible to non-CAD users.
See our website for more details.

TheoremXR

Visualization for Augmented (AR), Mixed (MR) and Virtual (VR) Reality
applications

Extended Reality — XR: Augmented, Mixed and Virtual Reality for the
Engineering Metaverse.

See our website for more details.

© 2025 Theorem Solutions. All Rights Reserved
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CADTranslate for CATIA V5 -JT

The CATIA V5 to JT translator may be installed on a number of machines each accessing a central network-
floating license.

The CATIA V5-JT Translator is a bi-directional direct database converter between the Dassault Systemes CATIA
V5 Modelling Application and the JT file format, used by the Siemens Teamcenter Visualization products.

It enables the user to convert all forms of 3D Mechanical Design Geometry and Assembly data, together with
system defined attribute information, colour information, between these two systems. This product is
designed for companies using CATIA V5 who have selected JT to be their main method of collaboration and
communication between OEMs and their customers or suppliers.

It is also @ major method of visualization and therefore companies using JT based solutions need to translate
their CATIA V5 data into the JT format.

The translator can be invoked in either an interactive or batch mode with the command line interface allowing
the conversion process to be integrated into any process oriented operation. Alternatively, from Theorem R18
the conversion process may be operated by using the new Theorem Unified Interface.

Primary Product Features

e Converts all types of geometry, wire frame, surfaces, trimmed surfaces (faces) and solid
models.

e Converts assembly structure between both systems.
e Converts attribute data including colour and layer information.
e Integrated with the CATIA V5 installation.

e The conversion process can be run Interactively, Batch Mode or using the new Unified
Interface

e Command line interface allows process integration.

e Data can be filtered by layer and entity type during processing. Geometry can be filtered and
selectively processed.

e Uses the CATIA V5 API and Siemens JTOpen API to read and write data.

e Increating JT files a number of data types can be generated. A facetted representation, a JT
Brep definition or an XT Brep definition. As standard a facetted representation is created
with the user selecting whether JT or XT Brep definition is created. Converts all types of
geometry, wire frame, surfaces, trimmed surfaces (faces) and solid models.

© 2025 Theorem Solutions. All Rights Reserved



@ THeOREM User Guide CATIA VS - IT

Primary Product benefits?

e Being a direct database converter all pre and post processing is eliminated, saving time.

e Reduce costs due to processing time and increase overall conversion success levels by filtering
input data and focusing the conversion to only those elements required.

e Reduce costs and risks associated to accessing the wrong version of data by integrating the
conversion process into a related business processes.

e  With over 20 years of industrial use Theorem translation products robustness and quality is well
proven, reducing your business risk.

This document will focus specifically on guidance for the use of the Visualize 3D for CATIA V5 —JT product. For
information regarding any of Theorem’s product ranges please contact sales@theorem.com

© 2025 Theorem Solutions. All Rights Reserved
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Getting Started

Documentation & Installation Media

The latest copy of the User Guide documentation can be found on our web site at:

http://www.theorem.com/Documentation

Each product has a specific link that provides user documentation in the form of PDF and Tutorials.

The latest copy of Theorem software can be found via the link above and by searching for the specific product.
Each product has a specific link to the Product Release Document, which contains a link to the download
location of the installation CD.

Alternatively, you can request a copy of the software to be shipped on a physical CD.

Installation

The installation is run from the .msi file download provided. For full details of the installation process, visit
www.theorem.com/documentation and select Ul from the product selection list.

License Configuration

To run any product a valid license file is required. The Flex License Manager is run from the .msi file download
provided. For full details of the installation process, visit www.theorem.com/documentation

Using the Product

To use the product, follow the documented steps found in this document or follow the online video tutorials
which can be found from www.theorem.com/documentation

© 2025 Theorem Solutions. All Rights Reserved
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Using the Product

Default Translations

Default Translation — via the Unified Interface

User Guide CATIA VS -JT

The Unified Interface can be started via the Start Menu — if a shortcut was added during installation.

Alternatively, the Unified Interface can be run via a Windows Explorer selection in:
<Ul_installation_directory>\bin\Unified_Interface.cmd

The following interface will be launched:

& Theorem Solutions Unified Interface:

=5 [ |

= B EBII B

ADverter Logs ¥

Activity:| L nist.c = |

ion:(CADver v | Log:(Summary = | [ Options

Warning TS_INST defined in general environment
Sourcing Theorem Environment from :-
C:\Thecrem\CAD_18.0_CASPDF_WIN64.01\bin\..\ts_env.bat
Setting run time environment please wait ...

Tsing TS_INST = C:\Theorem\CAD 18.0_CASEDF_WING4.01
using CATIRVS_INST = C:\cad apps\CATIA V5\B24

TUsing Platform win bé4

Launching translation pleass wait ...

[m] »

< i ] B

&

» B (B =%E

libs

samples
- catia5
NIST

» U rear_suspens

Open  External Preset  Custom Horizontal Vertica File | |CADverter |CADverter Configuration |CADverter || Product Viewer Event
Apps~ | Layouts~ Layouts=  Split 3 Browser| | Activity | Batch Manager Logs || Structure Viewer
&3 CADverter Activity ¥ File Browser ¥
C:\Theorem\CAD_lS‘Z_( Options = View v Filter: |All Files (%)
D Action  Model Name  System  Configuratior Date = | CADL16.2 CASIT WING: - Name
v )l B4 i) nist_cte 01 ssmel_ct5210_rd CATPart 1,
v L bin i) nist_ctc_02_asmel_ct5210_rc.CATPart 3
v )i data o8 nist_ctc_03_asmel_ct5210_rc.CATPart 1,
b etc 81 nist_ctc 04 asmel ct5210_rd CATPart
’ guides &) nist_ctc 05 asmel ct5210_rd CATPart
b INSTALL || NIST_MBE_Model Disclaimer.txt
[T
»

PR
» pdf
» saveas_pdf
- CAD_18.2_CASNX_WINE
4 B24 -
NIST Date modified: 12/06/2015 10:16
} File folder ltems: 6

-

(7]

B R D eatchoff >
2

2

@ CATIAVS-6R2014 | &
From Active Configurations 3
JT | <default> -lE
2

@JT

From Active Configurations

V5 | <default> -

The default layout is split into 4 primary areas, which can be altered to the users prefer:
The simplest way to translate from CATIA V5 or JT is to drag a file from the file Browser Pane on to the Active

Configurations for the translation you require.

Translation

Active
Configurations

T (o E
Activity — -
B B EHE e » B
= e (R e (6
[ Ee— ® R %
C— v at b2 | #] Oonars = v e sives (B ] () camun vlifRoona i
S5 CADvter Logs. ¥ - I
Aciy{Laniis v Tanetion GADver v Lo Summary =
Output
Logs

File
Browser
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Eﬂl ‘x I_) ba.

ptions »  View =  Filter: | All Files (*5) « @ CATIA V5-6 R2014

- Mame
45l) nist_ctc_01_asmel_ct5210_rd.CATRart 1!
@ nist_ctc_02_asmel_ct5210_rc.CATPart \3,!
@ nist_ctc_03_asmel_ct5210_rc.CATPart 1.
i) nist_ctc_04_asmel_ct5210_rd.CATPart 2. @ T
@ nist_ctc_05_asmel ct5210 rd CATPart 1.
=] NIST_MBE_Meodel_Disclaimer.txt

From Active Configurations

JT | <default> -

sio)e|suel)

From Active Configuraticns

"JS <default>

On completion, the Unified Interface will display the activity information and details from the log file created
during the translation, if requested, in the Translation Activity and Output Log panes, respectively.

The generated output data can be located by selecting the translation from the Activity pane and opening the
output folder:

@ x| & | CAThe

aon Madel Name System Configuratior Date

Direct nist_ctc_01_asn CATIAS24 to b <default — M2 IMELHNTE A
|§| View The Log

I:- Wiew the Input File Product Structure

8.2_CASMX_WING4.01

T2 View the Output File Product Structure

i Open output folder in File Explorer ﬁ
Ed Create an Audit Trail Package -
B Re-process the translation

% CADverter Logs ¥

(& Re-run all selected translations
" lmﬂi Translation:[C.&Dver v] Log:[Summar} 75 Delete all selected translations

- i . . e :
T defined in general environme || Properties

‘~onment from :- I |
o4 n\bind. .\ t3_env.bat

Default Translation — via the Command Line
Running a translation via the command line can be carried out via the cad_run.cmd file located in the
<installation_directory>\bin directory. The format of the command is as follows when translating from CATIA
V5 to JT:
<Translator_installation_directory>\bin\cad_run.cmd CATIA5[XX]_JT —i <input_file> -o <output_file>
The format of the command is as follows when translating from JT to CATIA V5:
<Translator_installation_directory>\bin\cad_run.cmd JT_CATIA5[XX] —i <input_file> -o <output_file>
(Note! Replace the [XX] seen in the example with the version of CATIA V5 you are using. E.g. for CATIA V5 R34
(V5-6 R2024), change to CATIA534):

© 2025 Theorem Solutions. All Rights Reserved
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C:\>"C:\Program Files\Theorem\27.0\bin\cad_run.cmd" CATIA534_JT -i "C:\Program Files\Theorem\27.0\samples\catia5\NIST\ni

The example above will translate a CATIA V5 sample file provided within the installation and finish with the
following screen output when successful:

Translation Complete...
Exporting Parts and Assembly to JT Files

e e e ok o vk ok o ok ok e ok ok ke ok ok ok ok o ok ok e ke ok e ok ok ke ke ke e ke
* JT file successfully created *
* C:\TEMP\NIST_Output.jt *

E

e e e e e e e e e ke ke ok ok ok ok ok ok ok ok ok ok ok ok ok ok ok ke ke ke ke ke ke ke ke ke ke ke ke ke ke ke ke ke ke ke ok ok ok ok ke

*
* CATIAS to JT conversion ...

* ... Completed Successfully
* Output JT file created

*

e e e e e e e e e e e e e ke ke ke ok ok ok ok ok ok ok ok ok ok ok ok ok ke ok ok ok ok ok ok ke ke ke e e e e e e e e e e e e

The file will be output to the target location. In this case:
C:\Temp\NIST_Output.jt

© 2025 Theorem Solutions. All Rights Reserved
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Translator Customization

The Theorem translator allows the information that is read from the source system and written to the target
system to be tailored via a set of user specified arguments. Commonly used arguments are supported via the
Unified Interface, with Advanced Arguments being described within this document for use in the Unified
Interface or via the Command Line invocation.

Common Options for CATIA V5 to JT

Within the Configuration Manager pane of the Unified Interface, arguments that can be specified when
publishing CATIA V5 data into JT are grouped into 4 areas:

CATIA V5 Read — Those arguments that affect how data is read from CATIA V5
JT Write — Those arguments that affect how the data is written to JT
Entity Mask — Those arguments that allow specific read entities to be masked

General — Those arguments that are common to ALL Publishing activities regardless of source
data.

CATIA V5 Read Arguments

The image below shows the CATIA V5 Read arguments that are available, with their default settings:

CATIA V5 Read | JT Write | Entity Mask | General

Option Name Value
Read PMI L]
All
v
Read FTA Reference Geometry ]
Maintain CATIA V5 Instance Names |:|
Read Face Colours ]
Read Face Opacity ]

Each of these options is described below:

Option Description
Read PMI Enables PMI data read from the V5 file. (Default is ON).

e Command Line Syntax:
o dont_read_pmi-to turn off

© 2025 Theorem Solutions. All Rights Reserved
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Note! When ‘read_pmi’ is enabled it also enables the ‘fill_pmi_arrows’, ‘fill_pmi_text’ and
‘omi_filled_text’ options. These can be overridden by setting the Advanced arguments:
‘dont_fill_pmi_arrows’ and/or ‘dont_fill_pmi_text’

PMI Level A secondary argument to ‘Read PMI’ and allows control of the level of PMI to be read.
Default is ALL when ‘Read PMI’ is marked as ON.

e Options Available (command line syntax in italics and square brackets next to the
option)
o All-[read_pmi]

o Part Level - [read_part_pmi]

o Assembly Level - [read_assy_pmi]

o Assembly Set (From CATPart) - [read_part_assy_pmi]
o Assembly Set (All) - [read_all_assy_pmi]

Read A secondary argument to ‘Read PMI’ and allows the control over whether captures are
Captures read as part of the process. Default is ON when ‘Read PMI’ is marked as ON.

e Command Line Syntax:
o read_captures

o dont_read_captures —to turn off

Read FTA Enables reading of FTA Reference Geometry (Default is Off)
Reference
e Command Line Syntax:
Geometry
o read_geometry —to turn on
Maintain Honours CATIA V5 Tools->Options->Infrastructure->Product Structure->Nodes
CATIA V5 Customization panel settings (Default is Off)
Instance Options
Names = -
'_rf- Options Cgr Management | EMOVIAvprn | MNodes Custermization | Product Strud
| Reference Product
T Genenl [ Custamized diplay
Display i _._I
DB Product mmstance, reference loaded
=0 Compatibility 3 4
a Customized display
&dParametm and Measi #SNF(FS0FFENF(FS0F)F5RPF
Dvices and Virtual Bx Product instance, reference unloaded
< Customized dusplay
Infrastructure == [=5RP=) Configure...
e Command Line Syntax:
o ditto_naming V5 —to turn on
Read Face Read the face colours (Default is OFF)
Colours
e Command Line Syntax:
o read_face_colours —to turn on
Read Face Read the opacity of the face (Default is OFF)
Opactity

© 2025 Theorem Solutions. All Rights Reserved
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e Command Line Syntax:
o read_materials — to turn on

JT Write Arguments
The image below shows the Write JT arguments that are available, with their default settings:

Description:  Default Translation Settings

CATIA V5 Read | JT Write | Entity Mask | General |

Option Name Value

W

Config File

Each of these options is described below:
Option Description

Config File Allows a JT configuration file to be specified.
Please see Appendix B for a full description of the JT config file format.

e Command Line Syntax
o -z [path_to_file]

CATIA V5 to JT Entity Masking Arguments

The image below shows the Masking arguments that are available, with their default settings:

Description:  Default Translation Settings

CATIA V5 Read | JT Write | Entity Mask | General

Option Name Value

Mask File

X W)

Each of these options is described below:

Option Description

© 2025 Theorem Solutions. All Rights Reserved
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Mask File Specifies the Mask File to be written to, that can be referenced by
future translations. A Mask file MUST be specified if masking is
required. The first line in this file is OFF ALL ENT:

e Command Line Syntax:
o Mask <filename>

Entity Types Translated Specifies a selection list from which to select which entity types are to
be processed. The following types are available:
|IPOIII,IICURI’IIISKIHIIISOL","|SO",IITEX"I"AXI"

e Command Line Syntax:
O Add any of the above to the specified mask file, one
entry per line prefixed by the word ON, e.g. ON POI to
ensure they are considered in the translation

Layers Translated Specifies a selection list from which to select which layers are to be
processed.

e Command Line Syntax:
o Asingle entry of ON ALL LAY must precede any Layer
Mask command.

o Add a list or range of numbers representing layer to
be processed to the specified mask file to ensure they
are NOT considered in the translation e.g. OFF LAY
114,149,166,167,168

Convert NO SHOW Geometry Enables Hidden geometry to be processed (Default is Off)

e Command Line Syntax:
o Add the following entry to the Mask file:

= ON NOSHOW
Convert NO SHOW Structure Enables Hidden Assembly Structure to be processed (Default is Off)

e Command Line Syntax:
o Add the following entry to the Mask file:

"=  ON NOSHOW STR
Convert NO SHOW PMI Enables Hidden PMI to be processed (Default = Off)

e Command Line Syntax:
o Add the following entry to the Mask file:

= ON NOSHOW PMI

CATIA V5 to JT General Arguments

© 2025 Theorem Solutions. All Rights Reserved
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CATIA V5 Read | JT Write | Entity Mask = General

Option Name Value
Mass Properties L]
Retain Assembly Structure
Advanced

The image below shows the General arguments that are available, with their default settings.
Each of these options is described below:

Option Description
Mass Properties Allows Mass Property information to be read from the source data and
written as attributes (Default is OFF)

e Command Line Syntax:
O mprops

Retain Assembly Structure Maintain the assembly structure during translation. (Default is ON)

e Command Line Syntax:
o offditto —to turn off

Advanced Allows any of the Command Line Advanced arguments documented to
be passed to the Unified Interface invocation.

Processing CATIA V5 FTA data to JT PMI

When using the optional CATIA V5 to JT PMI add-on module all CATIA V5 FTA data can be translated to JT PMI
output. This includes the translation of 3D dimensions and annotations which are mapped to the equivalent JT
PMI entities. In addition, CATIA V5 3D sections are also able to be translated. The CATIA V5 Capture
definitions, which manage the visibility of selective FTA elements as well as the view zoom and orientation, are
directly mapped to JT Model Views.

Options for Processing FTA Data with Filled Text

When creating 3D dimensions and annotations with the CATIA V5 FTA module the user can create the text
using either stick or filled text fonts. By default, the processing of CATIA V5 filled fonts will recreate the JT
output using JT text glyphs. One benefit of using JT glyph-based text definitions is that when the model is
reoriented, such that the initial view of the text is reversed, the user can select the annotations to be
automatically reoriented. If the filled font representation was created with a simple polygon fill only the
character outline would be reoriented and the polygon fill would remain in its original location making the
output unreadable.

© 2025 Theorem Solutions. All Rights Reserved



@ THeOREM User Guide CATIA V5 - JT

[ CATIAVS - [nist_ctc_05_asmel_ct5210_rd.CATPart]
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Select an object or a command

Picture showing typical CATIA V5 3D Dimensions and Annotations. Note, in the upper dimension the
dimensions values 5.000 +- .008 are created using a filled text font. The characters “ST” in the frame are
created using an unfilled stick font.
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Picture showing default JT output of V5 FTA data mapped to JT PMI representation
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w o s
= Men i liwOo @ IR Ak JFe-g-a] - R R
fq  (mPMI

.4 = Design Groups
pen | = Model Views
=4 W SavedViews

J =@ @MBD_A
- “gPOMBD_B

Picture showing the reorientation of the model with the text also reoriented. Note the text characters have
been rotated 180 degrees and are now readable with filled character representation.

To recreate the JT filled text using simple polygons, rather than JT text glyph representations, use the options
pmi_glyphs_off pmi_polygons together. The output representation will appear filled and look correct when
viewed in the authored orientation. However, filled text created with simple polygons, will not display
correctly if the data is reoriented and the text switching in JT is selected. The picture below shows an example
of the display when the data is rotated, and the text is reoriented. As you will see the simple polygon fill is still
in its original orientation making the dimension unreadable.

109
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Options for Processing FTA Data using Outline Text

When processing V5 FTA text data created with filled font definition the user can select to generate the JT text
representation as outline text, therefore removing the internal rendering. This is achieved by using the option
pmi_glyphs_off.

| Menu | o Bivl@ i@l 8l YS9 IREeGL 9

HPMI
& Design Groups
= Model Views
Lopmos
L g 7 SavedViews
+@OMBDA
=gOMBD_8

Picture showing JT PMI with filled text rendered in outline only. Note the option pmi_glyphs_off also removes
the filled arrowhead rendering.

If you would prefer to maintain filled arrowheads and only impact the characters to be recreated in outline
mode, then use the option dont_fill_pmi_text instead of the option pmi_glyphs_off. The resultant output is

shown in the picture below with the text drawn in outline and the arrowheads filled.

=¥ Menu | « o Eiwy|@Lig| 2l Y& Jhe-gsd=] - B

by mPMI

F _ # Design Groups
=t M :
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Common Options for JT to CATIA V5

Within the Configuration Manager pane of the Unified Interface, arguments that can be specified when
publishing JT data into CATIA V5 are grouped into 4 areas:

e JT Read — Those arguments that affect how data is read from JT
e CATIA V5 Write — Those arguments that affect how the data is written to JT

e General — Those arguments that are common to ALL Publishing activities

regardless of source data

JT Read Arguments
The image below shows the JT Read arguments that are available, with their default settings:

Description:  Default Translation Settings

JT Read | CATIA V5 Write | General |

Option Name Value
Read PMI |off -
Read Wireframe [ 4]
Read Points (]
IT Data Selection [Brep Preferred (then Fine Tristrip) v]
ULP Processing [Use default tessellation x
Config File \EJ
Convert XT Brep surfaces to NURBES )
Convert XT Brep Edge Curves to NURBS E
Filter via layer filter

Each of these options is described below.
Option Description
Read PMI Reads 3D PMI. Default is OFF.

e Command Line Syntax
o read_pmidim2_pmi

Read Wireframe Read JT wireframe data. Default is OFF.

e Command Line Syntax
o read_wire_frame

Read Points Read JT point data. Default is OFF.

e Command Line Syntax
o read_points

JT Data Selection Select Brep or tessellated data read. Default is ‘Brep Preferred (then fine
facet)’.
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e Command Line Syntax
o Brep Preferred (then Fine Facet): brep_pref

o Brep preferred (then Fine Tristrip): brep_pref_tri
o Brep Only: brep_only

o Fine Tristrip: fine_tristrips

o Coarse Tristrip: coarse_tristrips

o Fine Facet: fine_facets

o Coarse Facet: coarse_facets

ULP Processing How to process ULP data in the JT part. Default is ‘Use Default
Tessellation’.

e Command Line Syntax
o Use Default Tessellation: Default

o Tessellate ULP: tess_ulp
Config File Config File for Brep or ULP tessellation.
e Command Line Syntax
= -z [path tofile]

Convert XT Brep surfaces to Read XT Brep surfaces as NURBS surfaces (else read in native form).
NURBS Default is ON.

e Command Line Syntax
o noprep —to turn off

Convert XT Brep Edge Curves to Read XT Brep edge curves as NURBS curves (else read in native form.
NURBS Default is ON.

e Command Line Syntax
o rd_native_edge — to turn off

Filter via layer filter Supply layer filter(s) separated by commas and double quoted. Default
is OFF.

e Command Line Syntax
o layer_filter
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CATIA V5 Write Arguments
The image below shows the CATIA V5 Write arguments that are available, with their default settings:

JT Read | CATIA V5 Write | General

Option Name Value

Output Geometry File Type CATPart v
Write Face Colours |:|

Show Reference Planes []

Property Mapping File

Each of these options is described below:

Option Description
Output Geometry Output Geometry file type. Default is CATPart.
File Type

e Command Line Syntax
o CATPart: output_type CATPart

o Model: output_type model
o Cgr: output_type cgr
o Igs: output_type igs
o CATShape: output_type CATShape
o Tessellated: create_cgr
Write Face Colours ~ Writes face colours. Default is ON.

e Command Line Syntax
o FACE_COLOUR

o SOLID_COLOUR - to turn off

Show Reference Creates reference planes. Default is OFF.

Planes
e Command Line Syntax

o Show: dont_blank_planes
o No Show: Default
Property Mapping Path to Property Mapping File

Fil
e e Command Line Syntax

o cad_prop_map_file <file>
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JT to CATIA V5 General Arguments

JT Read | CATIA V5 Write | General

Option Name Value
Retain Assembly Structure
Advanced

The image below shows the General arguments that are available, with their default settings:
The option is described below:

Option Description
Retain Assembly Structure Maintain the assembly structure during translation. (Default is ON)

e Command Line Syntax:
o offditto —to turn off

Advanced Allows any of the Command Line Advanced arguments documented
below to be passed to the Unified Interface invocation
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Command Line Advanced Arguments

Advanced arguments can be added to the Command Line or the Ul General->Advanced field.

CATIA V5 Advanced Arguments

Argument

convert_curves
convert_surfaces
dont_fill_pmi_arrows
dont_fill_pmi_text
dont_read_captures
face_opacity
no_face_colour

noshow
noshow_geom
noshow_struct
noshow_pmi
output_mbd

read_geometry_edges

cad_prop_map_file <file>

off_ditto

Description

Converts curves to NURBS form

Converts surfaces to NURBS form

Disables the read of filled arrow information
Disables the read of filled text information
Disables the read of PMI Capture information

Read face opacity

Sets the default to SOLID colours

Reads hidden geometry / structure / pmi

Allows sub-part specification tree information to be read and presented
to JT as product structure information.

CATIA V5 allows the display of shaded surfaces and edges. This option
allows the translator to mimic this for FTA construction geometry by
promoting the edge curves to standalone wireframe.

Creates a cad property mapping file containing all attributes if one
doesn’t exist.

Removes all assembly structure and collapses ALL geometry into a
single selectable object

JT Advanced Arguments
Argument Description
read_wire_frame Enables reading of Wire Frame entities

read_ref_planes Reads reference planes
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Translating Interactively from within CATIA V5

The CATIA V5 to JT translator allows an active CATIA V5 Part or Assembly to be translated directly into JT or a
JT Part or assembly to be imported, directly from the CATIA V5 application.

In order to translate from within CATIA V5, the CATIA V5 application must be started from within a Theorem
environment, so that the appropriate CATIA V5 menus are loaded.

CATIA V5 can be started from a shortcut, if requested at installation time. Alternatively, it can be started via
the script provided in the Translator installation at:

<installation_directory>\bin\catia5r[version]_start.cmd

(where [version] should be substituted for the version of CATIA V5 that you have installed — e.g. 28, 29, 30,

31):
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Save As JT

Once CATIA V5 has been started it is possible for a model to be saved to JT. To do this, the user selects the File
-> Save As Menu Option. From the file browser window that opens, change the ‘Save as type’ option to be jt

(*.jt).
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T <« 240_CASIT > samples > catia5 > NIST D Search NIST

Organize ~ New falder
~
Name Date modified Type Size

cﬂ nist_ctc_01_asme1_ct5210_rd.CATPart 29/12/2016 13:48 CATIA Part 1,048 KB
cﬂ nist_ctc_02_asme1_ct5210_rc.CATPart 29/12/2016 13:48 CATIA Part 3,063 KB
=@ nist_ctc_03_asme1_ct5210_rc.CATPart 29/12/2016 13:48 CATIA Part 1,174 KB
=Q nist_ctc_04_asme1_ct5210_rd.CATPart 29/12/2016 13:48 CATIA Part 2,224 KB
=@ nist_ctc_05_asme1_ct5210_rd.CATPart 29/12/2016 13:48 CATIA Part 1,300 KB

User Guide CATIA VS -JT

File name: | nist_ctc_01_asme1_ct5210_rd.CATPart

Save as type: | CATPart (*.CATPart)

CATPart (~CATPart)
stl (*.stl)

~ Hide Folders igs (*.igs)

model (* model)
3dxml (*3dxml)
cgr (*.cqr)

wrl (*wrl)

Once selected, press the ‘Save’ button to create the JT data.

To add a user defined configuration to the process (created from the Theorem Ul), this can be selected from
the Tools>Options>Infrastructure>Theorem>CAA Export JT menu. The process will then use this defined

configuration to create the JT data as required.

Options

Export JT | Import JT Theorem-XR

-jr"l? Options

"'m General CAA Export JT

- Displa
@D Play Description

-0 ibili
o8 Compatibility ‘

|-B% Parameters and M caa IT Active Configurations

Default
Daimler Configuration

Process PMI R30
._- Infrastructure Testing

_ﬁ Product Structure
_I Material Library

_ Catalog Editor

_%' Devices and Virtuz

: RefreshConfigurationlist}] LaunchConfigurationManager I

- . Theorem

- Part Infrastructure

_%',:,J 3D Annotations In

PO |

@ OK
-

W Cancel I

Open JT Data
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Once CATIA V5 has been started it is possible for a model to be imported from JT using the File -> Open menu.
Once selected, find the JT data you wish to import into CATIA V5 and select it from the file browser. When
ready, press the ‘Open’ button from the menu to import.

EJ File Selection
“— v T « Theorem > 24.0_CASJT » samples > JT » NIST v [&] O Search NIST
Organize ~ New folder =
~
Name Date modified Type Size
& nist_ctc_01_asme1_ct5210_rd jt 01/09/2017 10:08 DirectModel Docu... 206 KB
& nist_ctc_02_asme1_ct5210_rc.jt 01/09/2017 10:08 DirectModel Docu... 951 KB
@ nist_ctc_03_asme1_ct5210_rcjt 01/09/2017 10:08 DirectModel Docu... 265 KB
& nist_ctc_04_asme1_ct5210_rd jt 01/09/2017 10:08 DirectModel Docu... 460 KB
& nist_ctc_05_asme1_ct5210_rd jt 01/09/2017 10:08 DirectModel Docu... 314 KB
@ nist_ftc_06_asme1_ct5240_rd.jt 31/05/2018 11:03 DirectModel Docu... 634 KB
é nist_ftc_08_asme1_ct5240_rcjt 29/12/2016 13:48 DirectModel Docu... 777 KB
v}; nist_ftc_09_asme1_ct5240_rd.jt 29/12/2016 13:48 DirectModel Docu... 593 KB
\j NIST_MBE_Model_Disclaimer.txt 29/12/2016 13:48 Text Document 1KB
File name: ~ | All Files (**)
[] Open as read-only

Cancel

To add a user defined configuration to the process (created from the Theorem Ul), this can be selected from
the Tools>Options>Infrastructure>Theorem>CAA Import JT menu. The process will then use this defined

configuration to create the JT data as required.

Theorem-XR

Options
L :
- ‘rl) Oppitans Export JT Import JT
- zeneral CAA Import JT
- Displa
@ IR Description
| 0@ bili Default Configuration
o Compatibility ‘

|-B% Parameters and M cAA IT Active Configuration

_%' Devices and Virtuz

..- Infrastructure

_ﬁ Product Structure

_E Material Library

_E Catalog Editor

RefreshConfigurationList | LaunchCenfigurationManager l

- - Theorem

- Part Infrastructure

_?'{:'5.;,1' 3D Annotations In

PR

@ ok |

@ Cancel I
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Theorem Import and Export

From the 'File' menu in CATIA V5 there are two options named 'Theorem Import' and 'Theorem Export'. This

allows you to import JT data or export to JT from the File menu. Select 'File' > 'Theorem Export' or 'Theorem
Import' to open the menu.

Theorem Import

Theorem Export

Theorem Export ? X Theorem Import ? X
SEOIURTEECOINES STOINURISEOINES
Export !I Configure | Import I Configure |

Export type ‘ Import from

T - T v

Input CATIA V5 File Name Input File Name

Product1.CATProduct I I

[ sanitize Save Geometry Leaf Nodes as

Output File Name ‘Q{[Par‘( v ‘ ‘

\Product1.jt I Output File Name |

Progress File Name I

\Product1.log I Progress File Name

< Retain Assembly Structure _J

] No Wait < Retain Assembly Structure

‘ @ OK J 9 Cancel] @ OK ) Cancell

- - )

Provide output file name and log file location, then press 'OK' to export the data.

To add a custom configuration, select the 'Configure' tab.
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Theorem Export ? X

THEOREM

SOLUTIONS

Export 1 Configure |

Configuration

pefautt |

CAS5JT_R34_QA

Configuration Description

Refresh ConfigurationlL List ] Launch Configuration Manager I

- @ OK i ) Cancel]

-

This allows the user to select a configuration, or create a new one by selecting the 'Launch Configuration
Manager' option. Once a configuration is decided simply select it from the list for it to be applied.

Appendix A — CATIA V5 Configuration

Introduction

This Appendix details how to define and configure the CATIA V5 and Theorem environment to work together.

Conventions

Release of CATIA V5
To indicate a release of CATIA V5 the notation <XX> shall be used. This needs to be replaced with the specific
release to be usedi.e.31, 32, 33, 34, 35.

Platform specific directory
Within the installation directory of CATIA V5 there is a platform specific directory i.e. win_b64. This directory
shall be referred to as <OSDS> in this Appendix.

Theorem Installation directory
The Theorem translator installation directory is set at installation time in the translator ts_env.bat file. This
directory shall be noted as <%TS_INST%> in this Appendix.

CATIA V5 Installation Directory

Upon installation of a CATIA V5 product the user will be asked to specify the installation directory. This is the
directory which contains the platform specific <OSDS> directory.

Having selected the CATIA V5 installation directory via the browse button, the installation process will record
the location of the CATIA V5 installation directory in the ts_env.bat file. This file is located in the Theorem

© 2025 Theorem Solutions. All Rights Reserved



@ THeOREM User Guide CATIA VS - IT

translator installation directory. If the location of CATIA V5 subsequently changes, the translator can be guided
to the changed location by modifying this file using a text editor to modify the ts_env.bat that is located in the
translator installation directory.

If no entry is included for DSLICENSING a warning dialog will be displayed which warns of the empty field.
Selecting Yes to continue will allow the installation to continue.

Missing Data p—— RO X

=

|" e ) The Value of the following Property has not been specified:
TS DSLICEMSING

You can run the configuration utility later, however the

property must be set before using the software.

| Do you wish to continue? I

| Yes | [ Mo

Running CATIA V5 Translators

Before running the translator the user must run CATIA V5 interactively at least once to configure the CATIA V5

environment and license settings. This can be achieved by running the catia5r<XX>_start script as follows:
<Translator_Installation_Directory>\bin\catia5r<XX>_start.cmd

Once CATIA has been run the Translator can run as described in the relevant product User Guide.

CATIA V5 Environment DIRENV & ENV
The default location for CATIA V5 to store its global environment files is in the global directory:
Windows 10:
C:\ProgramData\DassaultSystemes\CATEnv
Or
%APPDATA%\CATEnv
You can find this location by running:

%CATIAV5_INST%\<OSDS>\code\bin\setcatenv -h
The environment files are named in the form CATIA.V5RN.B<XX>.txt
If when installing CATIA V5 the default environment file location was replaced with another location then this
location needs to be indicated to the Translator by defining in the ts_env.bat the environment variable
CATIAVS5_DIRENV:

set CATIAV5_DIRENV=/some/directory

If the Theorem installation is needed to support multiple releases of CATIA. Then the user can define release
specific locations using:

set CATIAV5R<XX>_DIRENV=/some/directory
The Theorem translator will attempts to create its own environment file called TheoremCatia5R<XX>.txt. The

user must therefore have write permission to the CATEnv directory. If this is not possible an existing
environment file can be specified using the variable CATIAV5_ENV. e.g.
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set CATIAV5_ENV=CATIA.V5R31.B31
Note. the extension .txt is not required. The user can specify a release specific name using

CATIAV5R<XX>_ENV e.g.
set CATIAV5R31_ENV=CATIA.V5R31.B31

Checking the CATIA V5 Environment

A script is provided to check that the CATIA V5 environment is set up correctly. In a command window run the
command script:

%TS_INST%\bin\checkcatia5r<XX>env.cmd

Checking the Theorem Shared Library

A script is provided to ensure that the CATIA V5 environment is compatible with the Theorem shared library.
In a command window run the command script:

%TS_INST%\bin\checkcatia5r<XX>cadverter.cmd
A successful output is an indication that the location for CATIA V5 has been specified to the Theorem

translator correctly and that the correct version of the Theorem CATIA V5 translator products have been
installed.

Appendix B —JT Configuration File

Introduction

A configuration file contains the settings for your translations. The configuration file can be specified using the
command line option —config or -z.

If this is not supplied the following directories will be searched in the specified order for the named
configuration files: (TS_INST = Installed directory)

tess.config in the directory where the translator is run

tess.config in TS_INST\etc directory
Two example config files are provided in the TS_INST\etc directory, a standard tess.config one, and one that
illustrates the options required for large assembly processing, tessLargeAssm.config which is documented by

some comments within it.

The JT configuration file contains various sections, each containing different settings based on the section.

The Setup Section

The setup options in the configuration file define how your files are translated. The setup section is the first
part of the configuration file and contains a series of standard translator options.

© 2025 Theorem Solutions. All Rights Reserved



@ THeOREM User Guide CATIA VS - IT

To edit setup options
1. Open an existing configuration file with a text editor.
2. Edit the configuration file options listed in the table below.

3. Save the configuration with a .config extension

Option name Keywords Example
EAlTranslator EAITranslator { EAITranslator {
OutputDirectory "path to directory"  OutputDirectory = "/home/<user>/"
C PartsPath=
CommonPartsPath "path to directory” "ommon ar 5_ a )
/myaccount/jtparts/
. "RELATIVE"
chordalOption chordalOption = "RELATIVE"
"ABSOLUTE"
"PER_PART"
structureOption "MONOLITHIC" structureOption = "MONOLITHIC"

"FULL_SHATTER"

IIALLlI
) o WriteWhichFiles = "ALL"

WriteWhichFiles "ASSEMBLY_ONLY"
"PARTS_ONLY"
true
TRUE

compression compression = true
false
FALSE
true

triStripOpt TRUE

triStripOpt = false

false
FALSE

seamSewing
true

Note: Not available for TRUE seamSewing =true
Unigraphics.
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false

FALSE

seamSewingTol any integer seamSewingTol = 0.001

true

TRUE
includeBrep includeBrep = false
false

FALSE

"SINGLE"
brepPrecision brepPrecision = "SINGLE"
"DOUBLE"

true

TRUE
autoNameSanitize autoNameSanitize = true
false

FALSE

true

TRUE
updateChangedPartsOnly updateChangedPartsOnly = false
false

FALSE

true

TRUE
verboseReporting verboseReporting = false
false

FALSE

true

TRUE
writeAsciiAssembly writeAsciiAssembly = false
false

FALSE

. true
singlePartsNoAssem singlePartsNoAssem = false
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TRUE
false

FALSE

true

TRUE
smartLODgeneration smartLODgeneration = true
false

FALSE

true

TRUE
autoLowLODgeneration autoLowLODgeneration = true
false

FALSE

numLODs any integer numLODs = 3

close brace } }
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The Filter Section

The filter section of the configuration file contains the filename and metadata filtering information. Edit this
section if you want to change how the translator sanitizes filenames and filters metadata keys.

To edit filter options

1. Open an existing configuration file with a text editor.
2. Edit the configuration file options from the table below.

3. Save the configuration with a .config extension

Option name Keywords Example

Filter Filter { Filter {

FilenameSanitizeSet

"string of characters" FilenameSanitizeSet = "abc123."

FilenameSanitizeSetAdd

"string of characters" | FilenameSanitizeSetAdd ="41"

FilenameSanitizeSetDelete

"string of characters"” FilenameSanitizeSetDelete = "c

4 n H n - n
MetadataKe string of characters” MetadataKey = "metadata key to exclude
close brace

} }

The Metadata Section

The metadata section sets which metadata to attach to all parts, assemblies and nodes of the model.

Note: Be sure to add these options to the configuration file in pairs: one line to define the metadata key
and one line to define the metadata value.

To edit metadata options
1. Open an existing configuration file (.CONFIG) in a text editor.
2. Edit the configuration file options shown in the table below.

3. Save the configuration with a .config extension

Option name Keywords Example
Metadata Metadata { Metadata {
AddToParts

"string of characters" AddToParts = "<metadata key>"

AddToParts = "<metadata value>"
AddToAssemblies

"string of characters” AddToAssemblies = "<metadata key>"
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AddToAssemblies = "<metadata value>"

EER "string of characters" AddToAlINodes = "<metadata key>"

AddToAllINodes = "<metadata value>"

}

close brace }

The Level of Detail Section

The level of detail section of the configuration file contains the tessellation and simplification information for
each level of detail in the file.

This section consists of several sets of level of detail (LOD) information, and the number of these sets depends
on the number you specified on the numLODs line in the configuration file.

To edit level of detail options
1. Open an existing configuration file in a text editor.
2. Edit the configuration file options listed below.

3. Save the configuration with a .config extension

Option name Keywords Example
LOD LOD "lod number" { LOD "1" {
Level any integer Level =1
Chordal any number Chordal = 0.001
Angular any number Angular = 25
Length any number Length=1
FeatureSuppression any integer FeatureSuppression = 0
Simplify any number Simplify = 0.60
close brace } }

The JT Options Section

The JT Options section of the configuration file contains arguments for JT data.

To edit special options

1. Open an existing configuration file with a text editor.
2. Edit the configuration file options shown in the table below.

3. Save the configuration with a .config file extension.
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Option

JtOptions

AddSemanticPMI

AnnotationPlanesViewsetName

AppendCADExtension

BrepType

BrepWireframe

CadPropertyMappingFile

CollapseHierarchy

DefaultLayerFilter
EnhanceColour

ExpandPart

Keyword

JtOptions {

true

TRUE

false

FALSE

Character string

true

TRUE

false

FALSE

XT
T
XTT

true

TRUE

false

FALSE

Character String

SOLtoDetail

toSets

toPart
SURandFACtoDetail
toPartOptimized
expandPart
"Character String"
true

TRUE

false
FALSE
true

User Guide CATIA VS -JT

Example

JtOptions {

AddSemanticPMI = true

AnnotationPlanesViewsetName
= “Views”

AppendCADExtension = false

BrepType = true

BrepWireframe = false

CadPropertyMappingFile =
"%TS_INST%\data\jt\jt_property
__mapping.txt"
CollapseHierarchy = SOLtoDetail

un

DefaultLayerFilter =
EnhanceColour = true

ExpandPart = false

Default
Value

true

Views

true

XT

false

SOLtoDetai
|

“un

true

false
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TRUE

false
FALSE

ExplodeSolidsToFaces true ExplodeSolidsToFaces = false false
TRUE

false

FALSE
ExternalDetailNaming Character string ExternalDetailNaming =
FaceEdgeTol Real FaceEdgeTol = 0.000006 0.000006
FixDegenerateEdges true FixDegenerateEdges = true true

TRUE

“n “un

false

FALSE
FixSmallFeaturesOpenSolids true

TRUE

FixSmallFeaturesOpenSolids = false

false

false

FALSE
FixSmallFeaturesSolids true

TRUE

FixSmallFeaturesSolids = false false

false

FALSE
ForceBodyCreation true

TRUE

ForceBodyCreation = true true

false
FALSE

IncrementalSewing true IncrementalSewing = true true
TRUE

false
FALSE
IncrementalSewingNoOflterations  Integer IncrementalSewingNoOflteration = 5
s=5
JtBrepFixup true JtBrepFixup = False False
TRUE

false
FALSE

LayerFilter true LayerFilter = false false
TRUE

false
FALSE

ModelViews true ModelViews = true true
TRUE

false
FALSE
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NameRootNode

OutputUnits

ParasolidTolerantModelling

ParasolidTolerantModellingFactor

PImxmlPart

PImxmlIPropertyMappingFile

PmiAttributeMap

PmiAttributeMapFilename
PmiAttributeSplit

PmiGlyphs

PmiPolygons

ProduceTessellatedOutput

ReuseSolids

true
TRUE

false
FALSE
mm
cm

m
inches
true
TRUE

false
FALSE
Integer

true
TRUE

false
FALSE
Character String

true
TRUE

false

FALSE

"Character String"
true

TRUE

false
FALSE
2D
3D
off
true
TRUE

false
FALSE
true
TRUE

false
FALSE
true
TRUE

false
FALSE

User Guide CATIA VS -JT

NameRootNode = false

OutputUnits = mm

ParasolidTolerantModelling =
true

ParasolidTolerantModellingFacto
r=3
PImxmlPart = false

PImxmlPropertyMappingFile =
"%TS_INST%\data\jt\plmxml_pr
operty_mapping.txt"
PmiAttributeMap = false

“n

PmiAttributeMapFilename =
PmiAttributeSplit = false

PmiGlyphs = 3D

PmiPolygons = false

ProduceTessellatedOutput =
false

ReuseSolids = false

false

true

false

false

false

3D

false

false

false
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SavedViewsViewsetName

SewParasolidBodies

SewParasolidBodiesTol
ShineSetting

SimplifyGeometry

SplitDiscontinuousSurfaces

StructureOutputType

SubNode

UselnstanceNames

FlushRootNodeColour

ExplodeSolidintoFaces

AddSolidNodes

WriteSubAssyFiles

© 2025 Theorem Solutions. All Rights Reserved

"Character String"

true
TRUE

false
FALSE
Real
Integer

true
TRUE

false
FALSE
true
TRUE

false

FALSE

T

PLMXML
PLMXMUT
STEPBOM
STEPBOM_E2
true

TRUE

false
FALSE
true
TRUE

false
FALSE
true
TRUE

false
FALSE
true
TRUE

false
FALSE
true
TRUE

false
FALSE
true
TRUE

User Guide CATIA VS -JT

SavedViewsViewsetName =
“Catpures”
SewParasolidBodies = true

SewParasolidBodiesTol = 0.01
ShineSetting = 30

SimplifyGeometry = false

SplitDiscontinuousSurfaces =

false

StructureOutputType = JT

SubNode = false

UselnstanceNames = false

FlushRootNodeColour = false

ExplodeSolidintoFaces = false

AddSolidNodes = false

WriteSubAssyFiles = false

Captures

true

0.01
30

false

false

T

false

false

false

false

false

false
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false
FALSE

create_cadid true create_cadid = false false
TRUE

false

FALSE
cadid_attr Character String cadid_attr ="
cadid_fname Character String cadid_fname =
close brace } }

“n

The Catia5 Options Section

The Catia5 Options section of the configuration file contains arguments for Catia5 data.
To edit special options

1. Open an existing configuration file with a text editor.
2. Edit the configuration file options shown in the table below.

3. Save the configuration with a .config file extension.

Option Keyword Example Default
Value
Catia50ptions Catia50ptions { Catia50ptions {
ApplyTrimmingLimits true ApplyTrimmingLimits = false false
TRUE
false
FALSE
AssemblyReportFilename Character string AssemblyReportFilename = “”
ConvertSurfaceFaceLimits On ConvertSurfaceFaceLimits = On On
Off
Powerfill
ConvertGenericFilletSurfaceTol Real ConvertGenericFilletSurfaceTol = | 0.0001
0.0001
ConvertCurvesToNurbs true ConvertCurvesToNurbs = false false
TRUE
false
FALSE
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ConvertCurvesToNurbsTol

ConvertSurfacesToNurbs

ConvertSurfacesToNurbsTol

DecimalSeparator

FaceOpacity

FeatureName

GenerateEmptyPart

HybridJT

InstanceNaming
MaximumNurbsDegree

MergeCGRVertices

Real

None
Fillets
Spheres

Fillets+Spheres

Real

dot

comma

true

TRUE

false

FALSE

true

TRUE

false

FALSE

true

TRUE

false

FALSE

true

TRUE

false

FALSE
Character String
Integer

true

TRUE

false

User Guide CATIA VS -JT

ConvertCurvesToNurbsTol =
0.00001

ConvertSurfacesToNurbs = None

ConvertSurfacesToNurbsTol =
0.00001

DecimalSeparator = dot

FaceOpacity = true

FeatureName = false

GenerateEmptyPart = false

HybridJT = false

“n

InstanceNaming =
MaximumNurbsDegree = 5

MergeCGRVertices = false

0.00001

None

0.00001

dot

true

false

false

false

false
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NonManifold

OpacityZero

OutputMBD

OutputMBDLeafNodes

PrintInfo

ProcessCaptures

ProcessEsplice

ProcessElectrical

FALSE

true

TRUE

false

FALSE

Real

true

TRUE

false

FALSE

true

TRUE

false

FALSE

true

TRUE

false

FALSE

true

TRUE

false

FALSE

true

TRUE

false

FALSE

true

TRUE

false

User Guide CATIA VS -JT

NonManifold = false false
OpacityZero=0.1 0.1

OutputMBD = false false
OutputMBDLeafNodes = false false
Printinfo = true true
ProcessCaptures = false false
ProcessEsplice = false false
ProcessElectrical = false false
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FALSE

ProcessHybridJT true ProcessHybridJT = false false
TRUE

false

FALSE

ProcessLargeFaces HideLargeFaces ProcessLargeFaces = Datumfaces = DatumFace
AllowLargefaces >
DatumFaces
True

False

ProcessLayers ALL_LAYERS ProcessLayers = ALL_LAYERS ALL_LAYER
S

A comma separated
list of layer
numbers(0 - 255),
using hyphen '-' to
separate number
ranges.

ProcessMotion true ProcessMotion = false false

TRUE

false

FALSE

ProcessOpenSolids true ProcessOpenSolids = true true

TRUE

false

FALSE

ProcessPMI true ProcessPMI = false false

TRUE

false

FALSE

ProcessPoints true ProcessPoints = true true

TRUE

false
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FALSE

ProcessSolids true ProcessSolids = true true

TRUE

false

FALSE

ProcessWelds true ProcessWelds = false false

TRUE

false

FALSE

ProcessWireFrame true ProcessWireFrame = true true

TRUE

false

FALSE

ReadCachedCGR true ReadCachedCGR = false false
TRUE

false

FALSE

ReadCGREdges true ReadCGREdges = true true
TRUE

false

FALSE

ReadFaceColours true ReadFaceColours = true true

TRUE

false

FALSE

ReadFTAReferenceGeometry true ReadFTAReferenceGeometry = false

TRUE false

false

FALSE
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ReadHiddenData None ReadHiddenData = None None
Geometry
Structure

All

ReadInfiniteAxis true ReadInfiniteAxis = false false

TRUE

false

FALSE

ReadLeafNodeCGR true ReadLeafNodeCGR = true true
TRUE

false

FALSE

ReadMotion true ReadMotion = false false

TRUE

false

FALSE

ReadNOA true ReadNOA = false false
TRUE

false

FALSE

ReadScanData true ReadScanData = true true

TRUE

false

FALSE

ReadSpaceReservations true ReadSpaceReservations = false false

TRUE

false

FALSE

ReduceNurbsSurfaceDegree true ReduceNurbsSurfaceDegree = false
false
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TRUE

false

FALSE

RetainAssemblyStructure true RetainAssemblyStructure = true true

TRUE

false

FALSE

RetainTrailingZeros true RetainTrailingZeros = false false

TRUE

false

FALSE

SimplifyCurves true SimplifyCurves = false false

TRUE

false

FALSE

SimplifyProgressFile true SimplifyProgressFile = false false

TRUE

false

FALSE

SelectionSets true SelectionSets = false false

TRUE

false

FALSE

SurfaceChecking true SurfaceChecking = false false

TRUE

false

FALSE
SurfaceCheckingTol Real SurfaceCheckingTol = 0.001 0.001

TextName true TextName = false false
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TRUE

false

FALSE

TopGroupPerBody true TopGroupPerBody = false false
TRUE

false

FALSE

TrimFaceSurfaces true TrimFaceSurfaces = true true

TRUE

false

FALSE

UDFAXisSystems true UDFAXisSystems = false false
TRUE

false

FALSE

ViewContext Default3D ViewContext = Default3D Default3D
Unfolded

close brace } }

The Catia4 Options Section
The Catiad Options section of the configuration file contains arguments for Catia4 data.
To edit special options

1. Open an existing configuration file with a text editor.

2. Edit the configuration file options shown in the table below.

3. Save the configuration with a .config file extension.

Option Keyword Example Default
Value

Catia4Options Catiad4Options { Catia4Options {
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CatiaAssemblyPartsPath ASIS ColourVisualizationMode = ASIS ASIS
SET
LAYER
ENTITYTYPE
VIEW

“un

ColourVisualizationMode Character string AssemblyReportFilename =

FacetColour true FacetColour = false false

TRUE

false
FALSE
GroupPipes groupPipelines GroupPipes = groupPipelines groupPipeli
. nes
groupPipes
ungroupPipelines
ProcessEntityNames ALL_ENTITIES ProcessEntityNames = ALL_ENTITI
ALL_ENTITIES ES

A comma separated
list of ENTITY
names

ProcessFAC true ProcessFAC = true true

TRUE

false

FALSE

ProcessGPR true ProcessGPR = true true

TRUE

false
FALSE
ProcessLayers ALL_LAYERS ProcessLayers = ALL_LAYERS ALL_LAYER
S

CURRENT_LAYER_FI
LTER

A comma separated
list of layer
numbers(0 - 255),
using hyphen '-' to
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separate number
ranges.

ProcessModelNumber Integer ProcessModelNumber = 1 1

ProcessNOSHOW true ProcessNOSHOW = false false
TRUE

false

FALSE

ProcessNRBS true ProcessNRBS = true true

TRUE

false

FALSE

ProcessPIP true ProcessPIP = true true

TRUE

false

FALSE

ProcessPOI true ProcessPOl = true true

TRUE

false

FALSE

ProcessSetNames ALL_SETS ProcessSetNames = ALL_SETS ALL_SETS

A comma separated
lists of SET names

ProcessSKiI true ProcessSKI = true true

TRUE

false

FALSE

ProcessSOL true ProcessSOL = true true

TRUE

false

FALSE
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ProcessSTR true ProcessSTR = true true

TRUE

false

FALSE

ProcessSUR true ProcessSUR = true true

TRUE

false

FALSE

ProcessWireFrame true ProcessWireFrame = true true

TRUE

false

FALSE

UseColorMethod AS_FILED UseColorMethod = AS_FILED AS_FILED
SET
LAYER
ENTITY

close brace } }

The General Options Section
The General Options section of the configuration file contains general arguments.

To edit special options

1. Open an existing configuration file with a text editor.
2. Edit the configuration file options shown in the table below.

3. Save the configuration with a .config file extension.

Option Keyword Example Default
Value
GeneralOptions GeneralOptions { GeneralOptions {
MassProperties true MassProperties = false false
TRUE
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false
FALSE
ProgressFileInformation true ProgressFileInformation = true true
TRUE
false
FALSE
ProgressFileWarnings true ProgressFileWarnings = true true
TRUE
false
FALSE
ReportFilename Character String ReportFilename =
"%TEMP%\reportl.log”
AdvancedOptions Chatacter String AdvancedOptions = “”
close brace } }
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Appendix C—Error Codes

Common Error Codes

When processing data, the command screen or log file will show a return code as a status of the translation.
These are detailed below.

Return Code Description

0 Success

1 Issues during write leg such as incomplete run or no arguments given
2 Issue obtaining license

3 Input file argument issue or failure to open Progress File

4 Issue during read including no entities read

5 Failure to located secondary process (aka vwr_3dpdf.exe or vwr_jt.cmd)
6

7 Failure to open CATIA V5 document

8 Failure to find root node of CATIA V5 document

9 Failure to start CATIA V5 session

10 catiaScadverter.dll version doesn't match the catia5_XXX.exe

11 CATIA V4 data given as input file but bi _VAMAIN license available
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